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Chapter 1

Overview

Kubios HRV is an advanced tool for studying the variability of heart beat intervals. Due to its wide
variety of different analysis options and the easy to use interface, the software is suitable for researchers
and clinicians with varying premises. The software is mainly designed for the analysis of normal human
HRV, but can also be used e.g. for animal research.

Kubios HRV includes all the commonly used time- and frequency-domain variables of HRV. The
frequency-domain variables are calculated for both nonparametric (Fourier transform based) and para-
metric (autoregressive modeling based) spectrum estimates. In addition, several nonlinear HRV variables
are calculated such as Poincaré plot, recurrence plot analysis, detrended fluctuation analysis, approximate
and sample entropies, and correlation dimension.

The Kubios HRV, heart rate variability (HRV) analysis software1, is developed by the Biosignal
Analysis and Medical Imaging Group (BSAMIG) at the Department of Applied Physics, University of
Eastern Finland, Kuopio, Finland. The first version of the software was published already at the end of
2002 and is described in [33]. The current version is the third published version of the software. The
versions published so far (including the current version) and a short description of their main features
are listed below:

• Version 1.1 (released in September 2002): This was the first version of the Kubios HRV software
which was distributed only for Windows operating systems. It included the basic HRV time-domain
and frequency-domain analysis features. This version supported only ASCII RR interval data files
as input.

• Version 2.0 (released in October 2008): The second version of the software was released for both
Windows and Linux operating systems. The most significant new features in this version included
Suunto SDF/STE and Polar HRM data file support, RR interval artifact correction options, several
new nonlinear analysis features, and improved user interface.

• Version 2.1 (released in July 2012): The current version is released for Windows and Linux
operating systems. The main new features compared to previous versions include ECG data support
with integrated QRS detection algorithm, saving the analysis results in “SPSS friendly” ASCII file,
and several usability related improvements.

• Version 2.2 (released in May 2014): The current version is released for Windows, Linux and Mac
operating systems. New features compared to previous version include several improvements for
input data support (support for Garmin FIT files and EDF+ annotations was added and Biopac
file support updated), multiscale entropy (MSE) computation and several minor functionality and
usability modifications.

The latest version of Kubios HRV has been developed using MATLABr Release 2012a (The Math-
Works, Inc.) and was compiled to a deployable standalone application with the MATLABr Compiler
4.17. The MATLABr Compiler Runtime (MCR) version 7.17 is required for running Kubios HRV and
is included in the Kubios HRV installers.

1University of Eastern Finland has only limited rights to the software. These limited rights are governed by a certain
license agreement between University of Eastern Finland and The MathWorks, Inc.
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1.1. System requirements 5

1.1 System requirements

The system requirements given below should be considered as recommended system requirements. The
software may work also with lower system specifications, but will probably function slower or with reduced
usability.

1.1.1 Windows

• Operating system: Microsoftr Windows 7 or later

• Memory: 512 MB of RAM (1024 MB or higher recommended)

• Disk space: about 500 MB

• Desktop resolution of 1024×768 or higher

• The MATLABr Compiler Runtime 7.17 (32 bit version) installation

1.1.2 Linux

• Operating system: a Linux distribution with kernel 2.4.x or 2.6.x and glibc (glibc6) 2.3.4 and above.

• Memory: 512 MB of RAM (1024 MB or higher recommended)

• Desktop resolution of 1024×768 or higher

• Disk space: about 460 MB

• The MATLABr Compiler Runtime 7.17 (included in the Kubios HRV installer)

1.1.3 Mac OS

• Operating system: Mac OS X

• Memory: 512 MB of RAM (1024 MB or higher recommended)

• Desktop resolution of 1024×768 or higher

• Disk space: about 460 MB

• The MATLABr Compiler Runtime 7.17 installation

1.2 Installation

1.2.1 Windows

Make sure that you have administrative privileges (you will need them to install Kubios HRV). In order to
install Kubios HRV on a Windows computer, you need to first install the MATLABr Compiler Runtime
(MCR, version 7.17) on your computer. You can find the MCR installer from Kubios HRV home page
(http://kubios.uef.fi/). After you have installed the MCR, run the Kubios HRV installer file. Follow
the instructions given in the setup wizard to complete installation. You can launch the Kubios HRV by
selecting it from the created Start Menu folder or by clicking the Desktop icon (if created). Please note
that the starting of Kubios HRV also starts the MATLABr Compiler Runtime and may take some time
especially with older computers.

1.2.2 Linux

Run the Kubios HRV installer by typing sh KubiosHRV-linux-2.2 x86.run in the terminal and follow
the instructions given on screen. The Kubios HRV installer also includes the MATLABr Compiler
Runtime. NOTE: If you run the installer as root, Kubios HRV will be installed on your
computer system wide for all users. If you want to install Kubios HRV only for yourself,
run the installer as local user.

Kubios HRV
version 2.2

Biosignal Analysis and Medical Imaging Group, Department of Applied Physics
University of Eastern Finland, Kuopio, FINLAND

http://kubios.uef.fi/


1.3. Uninstallation 6

1.2.3 Mac OS

Download the zip-file from Kubios HRV home page (http://kubios.uef.fi/), which includes the MATLABr

Compiler Runtime (MCR, version 7.17) and the Kubios HRV application bundle. First install the MCR
on your computer (under the MCRinstaller folder, run InstallForMacOSX). After you have installed
the MCR, move the Kubios HRV application bundle into Applications on your computer. Kubios HRVis
then ready to be launched.

Note, that the zip-file includes also a Sample Data folder, which includes few sample files by which
you can use to make test runs with Kubios HRVor to examine the structure of certain Kubios compatible
file formats. The zip-file includes also a run_kubioshrv.sh script which you need to run if you are
experiencing problems in opening Kubios HRV. This script will add the necessary entries of MCR into
system path (see the readme file for its usage).

1.3 Uninstallation

1.3.1 Windows

The preferred and the most straightforward way of uninstalling Kubios HRV is to use the auto-
mated uninstaller. The uninstaller can be launched by selecting “Uninstall Kubios HRV” from
the software’s Start menu folder (the default Start menu folder is Kubios HRV). The software can
also be uninstalled from the “Add or Remove Programs” under the Windows Control Panel. The
uninstaller does not remove your preferences settings. These have to be deleted manually from
C:\Users\<username>\AppData\Roaming\KubiosHRV.

1.3.2 Linux

Open terminal and change directory to the Kubios HRV install directory. Run the command
sh uninstall_kubios.sh and follow instructions given on screen. NOTE: You may need root privi-
leges for running the uninstaller if you have installed Kubios HRV as root.

1.3.3 Mac OS

Move the installed applications (the MCR and Kubios HRV application) to trash.

1.4 Software home page

The Kubios HRV home page on the web can be found at

http://kubios.uef.fi/

where you can find current information on the software and download possible updates and related
material. If you have any trouble or questions regarding the software, please check first if
your particular problem or question has an answer in the FAQ/troubleshooting section at
the software homepage!

1.5 Structure of this guide

The aim of this guide is to help the user to get started with Kubios HRV. It should not, however, be
thought of as being an easy to follow step by step manual, but more like a reference material from which
you can probably find answers to your problems related to HRV analysis or usability of the software. The
structure of this guide is as follows.

After the overview chapter, from where you will find useful information about the system requirements
and installation, an introduction to heart rate variability is given in Chapter 2. This chapter starts with
a short discussion on the control systems of heart rate after which the extraction of heart beat periods is
discussed and the derivation of HRV time series is described. The rest of the chapter is focused on the
preprocessing of HRV data and gives a detailed description of the smoothness priors based detrending
approach.

Kubios HRV
version 2.2

Biosignal Analysis and Medical Imaging Group, Department of Applied Physics
University of Eastern Finland, Kuopio, FINLAND

http://kubios.uef.fi/
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1.5. Structure of this guide 7

In Chapter 3, the analysis methods included in the software are described. The descriptions of the
methods are divided into time-domain, frequency-domain and nonlinear categories and a summary of the
methods is given at the end of the chapter. For most of the methods, exact formulas for the different
variables are given and possible parameter selections are pointed out.

In Chapter 4, the description of the features and usage of the software is given. First, the input data
formats supported by the software are described and then the user interface through which the software
is operated is described. Then, different options for saving the analysis results are described and, finally,
instructions on how to set up the preference values for the analysis options are given. So if you want to
learn how to use all the functionalities of the software, this is the chapter to read!

In Chapter 5, two sample runs of the software are presented. The first sample run describes how
to analyze the lying and standing periods of the orthostatic test measurement (distributed along this
software) separately as stationary segments.

Kubios HRV
version 2.2

Biosignal Analysis and Medical Imaging Group, Department of Applied Physics
University of Eastern Finland, Kuopio, FINLAND



Chapter 2

Heart rate variability

Heart rate variability (HRV) describes the variations between consecutive heartbeats. The rhythm of
the heart is controlled by the sinoatrial (SA) node, which is modulated by both the sympathetic and
parasympathetic branches of the autonomic nervous system. Sympathetic activity tends to increase
heart rate (HR↑) and its response is slow (few seconds) [3]. Parasympathetic activity, on the other hand,
tends to decrease heart rate (HR↓) and mediates faster (0.2–0.6 seconds) [3]. In addition to central
control, there are some feedback mechanisms that can provide quick reflexes. One such mechanism is the
arterial baroreflex. This reflex is based on baroreceptors which are located on the walls of some large
vessels and can sense the stretching of vessel walls caused by pressure increase. Both sympathetic and
parasympathetic activity are influenced by baroreceptor stimulation trough a specific baroreflex arc, Fig.
2.1.

The continuous modulation of the sympathetic and parasympathetic innervations results in variations
in heart rate. The most conspicuous periodic component of HRV is the so-called respiratory sinus arrhyth-
mia (RSA) which is considered to range from 0.15 to 0.4 Hz [3]. In addition to the physiological influence
of breathing on HRV, this high frequency (HF) component is generally believed to be of parasympathetic
origin. Another widely studied component of HRV is the low frequency (LF) component usually ranging
from 0.04 to 0.15 Hz including the component referred to as the 10-second rhythm or the Mayer wave
[3]. The rhythms within the LF band have been thought to be of both sympathetic and parasympathetic
origin [3] even though some researchers have suggested them to be mainly of sympathetic origin [26]. The
fluctuations below 0.04 Hz, on the other hand, have not been studied as much as the higher frequencies.
These frequencies are commonly divided into very low frequency (VLF, 0.003-0.04 Hz) and ultra low fre-
quency (ULF, 0-0.003 Hz) bands, but in case of short-term recordings the ULF band is generally omitted
[44]. These lowest frequency rhythms are characteristic for HRV signals and have been related to, e.g.,
humoral factors such as the thermoregulatory processes and renin-angiotensin system [3].

Even though HRV has been studied extensively during the last decades within which numerous re-
search articles have been published, the practical use of HRV have reached general consensus only in two
clinical applications [44]. That is, it can be used as a predictor of risk after myocardial infarction [25, 20]
and as an early warning sign of diabetic neuropathy [5, 34]. In addition, HRV has been found to correlate
with, e.g., age, mental and physical stress, and attention, see, e.g., the review in [3].

The term HRV refers, in general, to changes in heart beat interval which is a reciprocal of the heart
rate. This is also the case here. The starting point for HRV analysis is the ECG recording from which
the HRV time series can be extracted. In the formulation of the HRV time series, a fundamental issue is
the determination of heart beat period.

2.1 Heart beat period and QRS detection

The aim in HRV analysis is to examine the sinus rhythm modulated by the autonomic nervous system.
Therefore, one should technically detect the occurrence times of the SA-node action potentials. This is,
however, practically impossible and, thus, the fiducial points for the heart beat is usually determined
from the ECG recording. The nearest observable activity in the ECG compared to SA-node firing is the
P-wave resulting from atrial depolarization (see Fig. 2.2) and, thus, the heart beat period is generally
defined as the time difference between two successive P-waves. The signal-to-noise ratio of the P-wave
is, however, clearly lower than that of the strong QRS complex which results primarily from ventricular
depolarization. Therefore, the heart beat period is commonly evaluated as the time difference between

8



2.1. Heart beat period and QRS detection 9

Figure 2.1: The four baroreflex pathways (redrawn from [42]). Variation in venous volume (∆Vv), left
ventricular contractility (VC), sympathetic and parasympathetic (vagal) control of heart rate (HR), stroke
volume (Vs), cardiac output (CO), total peripheral resistance (TPR), and arterial blood pressure (BPa).

Figure 2.2: Electrophysiology of the heart (redrawn from [27]). The different waveforms for each of the
specialized cells found in the heart are shown. The latency shown approximates that normally found in
the healthy heart.

the easily detectable QRS complexes.
A typical QRS detector consists of a preprocessing part followed by a decision rule. Several different

QRS detectors have been proposed within last decades [45, 35, 36, 18, 13]. For an easy to read review
of these methods, see [1]. The preprocessing of the ECG usually includes at least bandpass filtering to
reduce power line noise, baseline wander, muscle noise, and other interference components. The passband
can be set to approximately 5–30 Hz which covers most of the frequency content of QRS complex [35]. In
addition, preprocessing can include differentiation and/or squaring of the samples. After preprocessing,
the decision rules are applied to determine whether or not a QRS complex has occurred. The decision
rule usually includes an amplitude threshold which is adjusted adaptively as the detection progresses.
In addition, the average heart beat period is often used in the decision. The fiducial point is generally
selected to be the R-wave and the corresponding time instants are given as the output of the detector.

The accuracy of the R-wave occurrence time estimates is often required to be 1–2 ms and, thus, the
sampling frequency of the ECG should be at least 500–1000 Hz [44]. If the sampling frequency of the

Kubios HRV
version 2.2

Biosignal Analysis and Medical Imaging Group, Department of Applied Physics
University of Eastern Finland, Kuopio, FINLAND



2.2. Derivation of HRV time series 10

ECG is less than 500 Hz, the errors in R-wave occurrence times can cause critical distortion to HRV
analysis results, especially to spectrum estimates [31]. The distortion of the spectrum is even bigger
if the overall variability in heart rate is small [39]. The estimation accuracy can however be improved
by interpolating the QRS complex e.g. by using a cubic spline interpolation [10] or some model based
approach [4]. It should be, however, noted that when the SA-node impulses are of interest there is an
unavoidable estimation error of approximately 3 ms due to fluctuations in the AV-nodal conduction time
[42].

2.2 Derivation of HRV time series

After the QRS complex occurrence times have been estimated, the HRV time series can be derived. The
inter-beat intervals or RR intervals are obtained as differences between successive R-wave occurrence
times. That is, the n’th RR interval is obtained as the difference between the R-wave occurrence times
RRn = tn − tn−1. In some context, normal-to-normal (NN) may also be used when referring to these
intervals indicating strictly intervals between successive QRS complexes resulting from SA-node depo-
larization [44]. In practice, the NN and RR intervals appear to be the same and, thus, the term RR is
preferred here.

The time series constructed from all available RR intervals is, clearly, not equidistantly sampled,
but has to be presented as a function of time, i.e. as values (tn,RRn). This fact has to be taken into
account before frequency-domain analysis. In general, three different approaches have been used to get
around this issue [44]. The simplest approach that have been adopted in, e.g., [2] is to assume equidistant
sampling and calculate the spectrum directly from the RR interval tachogram (RR intervals as a function
of beat number), see the left panel of Fig. 2.3. This assumption can, however, cause distortion into the
spectrum [29]. This distortion becomes substantial when the variability is large in comparison with the
mean level. Furthermore, the spectrum can not be considered to be a function of frequency but rather of
cycles per beat [11]. Another common approach, adopted in this software, is to use interpolation methods
for converting the non-equidistantly sampled RR interval time series (also called the interval function) to
equidistantly sampled [44], see the right panel of Fig. 2.3. One choice for the interpolation method is the
cubic spline interpolation [29]. After interpolation, regular spectrum estimation methods can be applied.
The third general approach called the spectrum of counts considers a series of impulses (delta functions
positioned at beat occurrence times) [12]. This approach relies on the generally accepted integral pulse
frequency modulator (IPFM) which aims to model the neural modulation of the SA-node [42]. According
to this model, the modulating signal is integrated until a reference level is achieved after which an impulse
is emitted and the integrator is set to zero. The spectrum of the series of events can be calculated, e.g.,
by first lowpass filtering the event series and then calculating the spectrum of the resulting signal [11].

2.3 Preprocessing of HRV time series

Any artifact in the RR interval time series may interfere the analysis of these signals. The artifacts within
HRV signals can be divided into technical and physiological artifacts. The technical artifacts can include
missing or additional QRS complex detections and errors in R-wave occurrence times. These artifacts
may be due to measurement artifacts or the computational algorithm. The physiological artifacts, on
the other hand, include ectopic beats and arrhythmic events. In order to avoid the interference of such
artifacts, the ECG recording and the corresponding event series should always be manually checked for
artifacts and only artifact-free sections should be included in the analysis [44]. Alternatively, if the
amount of artifact-free data is insufficient, proper interpolation methods can be used to reduce these
artifacts, see, e.g., [22, 23, 30].

Another common feature that can alter the analysis significantly are the slow linear or more complex
trends within the analyzed time series. Such slow nonstationarities are characteristic for HRV signals
and should be considered before the analysis. The origins of nonstationarities in HRV are discussed, e.g.,
in [3]. Two kinds of methods have been used to get around the nonstationarity problem. In [48], it was
suggested that HRV data should be systematically tested for nonstationarities and that only stationary
segments should be analyzed. Representativeness of these segments in comparison with the whole HRV
signal was, however, questioned in [16]. Other methods try to remove the slow nonstationary trends
from the HRV signal before analysis. The detrending is usually based on first order [24, 32] or higher
order polynomial [40, 32] models. In addition, this software includes an advanced detrending procedure
originally presented in [43]. This approach is based on smoothness priors regularization.

Kubios HRV
version 2.2

Biosignal Analysis and Medical Imaging Group, Department of Applied Physics
University of Eastern Finland, Kuopio, FINLAND



2.3. Preprocessing of HRV time series 11
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Figure 2.3: Derivation of two HRV signals from ECG: the interval tachogram (middle panel) and inter-
polated RR interval series (bottom panel).

2.3.1 Smoothness priors based detrending approach

Let z ∈ RN denote the RR interval time series which can be considered to consist of two components

z = zstat + ztrend (2.1)

where zstat is the nearly stationary RR interval series of interest, ztrend is the low frequency aperiodic
trend component, and N is the number of RR intervals. Suppose that the trend component can be
modeled with a linear observation model as

ztrend = Hθ + e (2.2)

where H ∈ RN×p is the observation matrix, θ ∈ Rp are the regression parameters, and e is the observation
error. The task is then to estimate the parameters by some fitting procedure so that ẑtrend = Hθ̂ can be
used as the estimate of the trend. The properties of the estimate depend strongly on the properties of
the basis vectors (columns of the matrix H) in the fitting. A widely used method for the solution of the

estimate θ̂ is the least squares method. However, a more general approach for the estimation of θ̂ is used
here. That is, the so-called regularized least squares solution

θ̂λ = arg min
θ

{
‖z −Hθ‖2 + λ2‖Dd(Hθ)‖2

}
(2.3)

where λ is the regularization parameter and Dd indicates the discrete approximation of the d’th derivative
operator. This is clearly a modification of the ordinary least squares solution to the direction in which
the side norm ‖Dd(Hθ)‖ gets smaller. In this way, prior information about the predicted trend Hθ can
be implemented to the estimation. The solution of (2.3) can be written in the form

θ̂λ = (HTH + λ2HTDT
dDdH)−1HT z (2.4)

and the estimate for the trend which is to be removed as

ẑtrend = Hθ̂λ. (2.5)

Kubios HRV
version 2.2

Biosignal Analysis and Medical Imaging Group, Department of Applied Physics
University of Eastern Finland, Kuopio, FINLAND
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Figure 2.4: a) Time-varying frequency response of L (N − 1 = 50 and λ = 10). Only the first half of the
frequency response is presented, since the other half is identical. b) Frequency responses, obtained from
the middle row of L (cf. bold lines), for λ = 1, 2, 4, 10, 20, 100, and 500. The corresponding cut-off
frequencies are 0.213, 0.145, 0.101, 0.063, 0.045, 0.021 and 0.010 times the sampling frequency.

The selection of the observation matrix H can be implemented according to some known properties
of the data z. For example, a generic set of Gaussian shaped functions or sigmoids can be used. Here,
however, the trivial choice of identity matrix H = I ∈ RN×N is used. In this case, the regularization
part of (2.3) can be understood to draw the solution towards the null space of the regularization matrix
Dd. The null space of the second order difference matrix contains all first order curves and, thus, D2 is
a good choice for estimating the aperiodic trend of RR series. With these specific choices, the detrended
nearly stationary RR series can be written as

ẑstat = z −Hθ̂λ = (I − (I + λ2DT
2 D2)−1)z. (2.6)

In order to demonstrate the properties of the proposed detrending method, its frequency response is
considered. Equation (2.5) can be written as ẑstat = Lz, where L = I − (I + λ2DT

2 D2)−1 corresponds
to a time-varying finite impulse response highpass filter. The frequency response of L for each discrete
time point, obtained as a Fourier transform of its rows, is presented in Fig. 2.4 (a). It can be seen that
the filter is mostly constant but the beginning and end of the signal are handled differently. The filtering
effect is attenuated for the first and last elements of z and, thus, the distortion of end points of data is
avoided. The effect of the smoothing parameter λ on the frequency response of the filter is presented in
Fig. 2.4 (b). The cutoff frequency of the filter decreases when λ is increased. Besides the λ parameter
the frequency response naturally depends on the sampling rate of signal z.
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Chapter 3

Analysis methods

In this chapter, the analysis methods used in the software are introduced. The presented methods are
mainly based on the guidelines given in [44]. The presentation of the methods is divided into three
categories, i.e. time-domain, frequency-domain and nonlinear methods. The methods summarized in
Table 3.1.

3.1 Time-domain methods

The time-domain methods are the simplest to perform since they are applied straight to the series of
successive RR interval values. The most evident such measure is the mean value of RR intervals (RR) or,
correspondingly, the mean HR (HR). In addition, several variables that measure the variability within
the RR series exist. The standard deviation of RR intervals (SDNN) is defined as

SDNN =

√√√√ 1

N − 1

N∑
j=1

(RRj − RR)2 (3.1)

where RRj denotes the value of j’th RR interval and N is the total number of successive intervals.
The SDNN reflects the overall (both short-term and long-term) variation within the RR interval series,
whereas the standard deviation of successive RR interval differences (SDSD) given by

SDSD =
√
E{∆RR2

j} − E{∆RRj}2 (3.2)

can be used as a measure of the short-term variability. For stationary RR series E{∆RRj} = E{RRj+1}−
E{RRj} = 0 and SDSD equals the root mean square of successive differences (RMSSD) given by

RMSSD =

√√√√ 1

N − 1

N−1∑
j=1

(RRj+1 − RRj)2. (3.3)

Another measure calculated from successive RR interval differences is the NN50 which is the number of
successive intervals differing more than 50 ms or the corresponding relative amount

pNN50 =
NN50

N − 1
× 100%. (3.4)

In addition to the above statistical measures, there are some geometric measures that are calculated
from the RR interval histogram. The HRV triangular index is obtained as the integral of the histogram
(i.e. total number of RR intervals) divided by the height of the histogram which depends on the selected
bin width. In order to obtain comparable results, a bin width of 1/128 seconds is recommended [44].
Another geometric measure is the TINN which is the baseline width of the RR histogram evaluated
through triangular interpolation, see [44] for details.

3.2 Frequency-domain methods

In the frequency-domain methods, a power spectrum density (PSD) estimate is calculated for the RR
interval series. The regular PSD estimators implicitly assume equidistant sampling and, thus, the RR
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3.3. Nonlinear methods 14

interval series is converted to equidistantly sampled series by interpolation methods prior to PSD estima-
tion. In the software a cubic spline interpolation method is used. In HRV analysis, the PSD estimation
is generally carried out using either FFT based methods or parametric AR modeling based methods.
For details on these methods see, e.g., [28]. The advantage of FFT based methods is the simplicity of
implementation, while the AR spectrum yields improved resolution especially for short samples. Another
property of AR spectrum that has made it popular in HRV analysis is that it can be factorized into
separate spectral components. The disadvantages of the AR spectrum are the complexity of model order
selection and the contingency of negative components in the spectral factorization. Nevertheless, it may
be advantageous to calculate the spectrum with both methods to have comparable results.

In this software, the HRV spectrum is calculated with FFT based Welch’s periodogram method and
with the AR method. Spectrum factorization in AR method is optional. In the Welch’s periodogram
method the HRV sample is divided into overlapping segments. The spectrum is then obtained by averaging
the spectra of these segments. This method decreases the variance of the FFT spectrum.

The generalized frequency bands in case of short-term HRV recordings are the very low frequency
(VLF, 0–0.04 Hz), low frequency (LF, 0.04–0.15 Hz), and high frequency (HF, 0.15–0.4 Hz). The
frequency-domain measures extracted from the PSD estimate for each frequency band include abso-
lute and relative powers of VLF, LF, and HF bands, LF and HF band powers in normalized units, the
LF/HF power ratio, and peak frequencies for each band (see Table 3.1). In the case of FFT spectrum,
absolute power values for each frequency band are obtained by simply integrating the spectrum over the
band limits. In the case of AR spectrum, on the other hand, if factorization is enabled distinct spectral
components emerge for each frequency band with a proper selection of the model order and the absolute
power values are obtained directly as the powers of these components. If factorization is disabled the AR
spectrum powers are calculated as for the FFT spectrum. The band powers in relative and normalized
units are obtained from the absolute values as described in Table 3.1.

3.3 Nonlinear methods

Considering the complex control systems of the heart it is reasonable to assume that nonlinear mechanisms
are involved in the genesis of HRV. The nonlinear properties of HRV have been analyzed using measures
such as Poincaré plot [6, 7], approximate and sample entropy [41, 14], detrended fluctuation analysis
[37, 38], correlation dimension [17, 19], and recurrence plots [47, 46, 49]. During the last years, the
number of studies utilizing such methods have increased substantially. The downside of these methods
is still, however, the difficulty of physiological interpretation of the results.

3.3.1 Poincaré plot

One commonly used nonlinear method that is simple to interpret is the so-called Poincaré plot. It is
a graphical representation of the correlation between successive RR intervals, i.e. plot of RRj+1 as a
function of RRj as described in Fig. 3.1. The shape of the plot is the essential feature. A common
approach to parameterize the shape is to fit an ellipse to the plot as shown in Fig. 3.1. The ellipse
is oriented according to the line-of-identity (RRj = RRj+1) [6]. The standard deviation of the points
perpendicular to the line-of-identity denoted by SD1 describes short-term variability which is mainly
caused by RSA. It can be shown that SD1 is related to the time-domain measure SDSD according to [6]

SD12 =
1

2
SDSD2. (3.5)

The standard deviation along the line-of-identity denoted by SD2, on the other hand, describes long-term
variability and has been shown to be related to time-domain measures SDNN and SDSD by [6]

SD22 = 2 SDNN2 − 1

2
SDSD2. (3.6)

The standard Poincaré plot can be considered to be of the first order. The second order plot would be
a three dimensional plot of values (RRj ,RRj+1,RRj+2). In addition, the lag can be bigger than 1, e.g.,
the plot (RRj ,RRj+2).

3.3.2 Approximate entropy

Approximate entropy (ApEn) measures the complexity or irregularity of the signal [14, 41]. Large values
of ApEn indicate high irregularity and smaller values of ApEn more regular signal. The ApEn is computed
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Figure 3.1: Poincaré plot analysis with the ellipse fitting procedure. SD1 and SD2 are the standard
deviations in the directions x1 and x2, where x2 is the line-of-identity for which RRj = RRj+1.

as follows.
First, a set of length m vectors uj is formed

uj = (RRj ,RRj+1, . . . ,RRj+m−1), j = 1, 2, . . . N −m+ 1 (3.7)

where m is called the embedding dimension and N is the number of measured RR intervals. The distance
between these vectors is defined as the maximum absolute difference between the corresponding elements,
i.e.,

d(uj , uk) = max
{
|RRj+n − RRk+n|

∣∣n = 0, . . . ,m− 1
}
. (3.8)

Next, for each uj the relative number of vectors uk for which d(uj , uk) ≤ r is calculated. This index is
denoted with Cmj (r) and can be written in the form

Cmj (r) =
nbr of

{
uk
∣∣ d(uj , uk) ≤ r

}
N −m+ 1

∀ k. (3.9)

Due to the normalization, the value of Cmj (r) is always smaller or equal to 1. Note that the value is,
however, at least 1/(N −m+ 1) since uj is also included in the count. Then, take the natural logarithm
of each Cmj (r) and average over j to yield

Φm(r) =
1

N −m+ 1

N−m+1∑
j=1

lnCmj (r). (3.10)

Finally, the approximate entropy is obtained as

ApEn(m, r,N) = Φm(r)− Φm+1(r). (3.11)

Thus, the value of the estimate ApEn depends on three parameters, the length m of the vectors uj ,
the tolerance value r, and the data length N . In this software the default value of m is set to be m = 2.
The length N of the data also affects ApEn. When N is increased the ApEn approaches its asymptotic
value. The tolerance r has a strong effect on ApEn and it should be selected as a fraction of the standard
deviation of the data (SDNN). This selection enables the comparison of different data types. A common
selection for r is r = 0.2SDNN , which is also the default value in this software.

3.3.3 Sample entropy

Sample entropy (SampEn) is similar to ApEn, but there are two important differences in its calculation
[41, 21]. For ApEn, in the calculation of the number of vectors uk for which d(uj , uk) ≤ r also the
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3.3. Nonlinear methods 16

vector uj itself is included. This ensures that Cmj (r) is always larger than 0 and the logarithm can be
applied, but at the same time it makes ApEn to be biased. In sample entropy the self-comparison of uj
is eliminated by calculating Cmj (r) as

Cmj (r) =
nbr of

{
uk
∣∣ d(uj , uk) ≤ r

}
N −m

∀ k 6= j. (3.12)

Now the value of Cmj (r) will be between 0 and 1. Next, the values of Cmj (r) are averaged to yield

Cm(r) =
1

N −m+ 1

N−m+1∑
j=1

Cmj (r) (3.13)

and the sample entropy is obtained as

SampEn(m, r,N) = ln (Cm(r)/Cm+1(r)). (3.14)

The default values set for the embedding dimension m and for the tolerance parameter r in the
software are the same as those for the approximate entropy calculation. Both ApEn and SampEn are
estimates for the negative natural logarithm of the conditional probability that a data of length N , having
repeated itself within a tolerance r for m points, will also repeat itself for m + 1 points. SampEn was
designed to reduce the bias of ApEn and has a closer agreement with the theory for data with known
probabilistic content [21].

3.3.4 Multiscale entropy (MSE)

Multiscale entropy (MSE) is an extension of SampEn in the sense that it incorporates two procedures [8]

1. A course-graining process is applied to the RR interval time series. Multiple course-grained time
series are constructed for the time series by averaging the data points within non-overlapping
windows of increasing length τ , where τ represents the scale factor and is selected to range between
τ = 1, 2, . . . , 20. The length of each course-grained time series is N/τ , where N is the number of
RR intervals in the data. For scale τ = 1, the course-grained time series is simply the original
beat-to-beat RR interval time series.

2. SampEn is calculated for each course-grained time series. SampEn as a function of the scale factor
produces the MSE. MSE for scale factor τ = 1 returns standard SampEn (computed from the
original data points).

3.3.5 Detrended fluctuation analysis

Detrended fluctuation analysis (DFA) measures the correlation within the signal. The correlation is
extracted for different time scales as follows [37]. First, the RR interval time series is integrated

y(k) =

k∑
j=1

(RRj − RR), k = 1, . . . , N (3.15)

where RR is the average RR interval. Next, the integrated series is divided into segments of equal length
n. Within each segment, a least squares line is fitted into the data. Let yn(k) denote these regression
lines. Next the integrated series y(k) is detrended by subtracting the local trend within each segment
and the root-mean-square fluctuation of this integrated and detrended time series is calculated by

F (n) =

√√√√ 1

N

N∑
k=1

(y(k)− yn(k))2. (3.16)

This computation is repeated over different segment lengths to yield the index F (n) as a function of
segment length n. Typically F (n) increases with segment length. A linear relationship on a double log
graph indicates presence of fractal scaling and the fluctuations can be characterized by scaling exponent
α (the slope of the regression line relating logF (n) to log n. Different values of α indicate the following
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Figure 3.2: Detrended fluctuation analysis. A double log plot of the index F (n) as a function of segment
length n. α1 and α2 are the short term and long term fluctuation slopes, respectively.

α = 1.5: Brown noise (integral of white noise)
1 < α < 1.5: Different kinds of noise
α = 1: 1/f noise
0.5 < α < 1: Large values are likely to be followed by large value and vice versa
α = 0.5: white noise
0 < α < 0.5: Large value is likely to be followed by small value and vice versa

Typically, in DFA the correlations are divided into short-term and long-term fluctuations. In the
software, the short-term fluctuations are characterized by the slope α1 obtained from the (log n,logF (n))
graph within range 4 ≤ n ≤ 16 (default values). Correspondingly, the slope α2 obtained by default from
the range 16 ≤ n ≤ 64 characterizes long-term fluctuations, see Fig. 3.2.

3.3.6 Correlation dimension

Another method for measuring the complexity or strangeness of the time series is the correlation dimension
which was proposed in [15]. The correlation dimension is expected to give information on the minimum
number of dynamic variables needed to model the underlying system and it can be obtained as follows.

Similarly as in the calculation of approximate and sample entropies, form length m vectors uj

uj = (RRj ,RRj+1, . . . ,RRj+m−1), j = 1, 2, . . . , N −m+ 1 (3.17)

and calculate the number of vectors uk for which d(uj , uk) ≤ r, that is

Cmj (r) =
nbr of

{
uk
∣∣ d(uj , uk) ≤ r

}
N −m+ 1

∀ k (3.18)

where the distance function d(uj , uk) is now defined as

d(uj , uk) =

√√√√ m∑
l=1

(uj(l)− uk(l))
2
. (3.19)

Next, an average of the term Cmj (r) is taken

Cm(r) =
1

N −m+ 1

N−m+1∑
j=1

Cmj (r) (3.20)
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Figure 3.3: Approximation of the correlation dimension D2 from the (log r, logCm(r)) plot.

which is the so-called correlation integral. The correlation dimension D2 is defined as the limit value

D2(m) = lim
r→0

lim
N→∞

logCm(r)

log r
. (3.21)

In practice this limit value is approximated by the slope of the regression curve (log r, logCm(r)) [19].
The slope is calculated from the linear part of the log-log plot, see Fig. 3.3. The slope of the regression
curves tend to saturate on the finite value of D2 when m is increased. In the software, a default value of
m = 10 was selected for the embedding.

3.3.7 Recurrence plot analysis

Yet another approach, included in the software, for analyzing the complexity of the time series is the
so-called recurrence plot (RP) analysis. In this approach, vectors

uj = (RRj ,RRj+τ , . . . ,RRj+(m−1)τ ), j = 1, 2, . . . , N − (m− 1)τ (3.22)

where m is the embedding dimension and τ the embedding lag. The vectors uj then represent the
RR interval time series as a trajectory in m dimensional space. A recurrence plot is a symmetrical
[N − (m− 1)τ ]× [N − (m− 1)τ ] matrix of zeros and ones. The element in the j’th row and k’th column
of the RP matrix, i.e. RP(j,k), is 1 if the point uj on the trajectory is close to point uk. That is

RP(j, k) =

{
1, d(uj − uk) ≤ r
0, otherwise

(3.23)

where d(uj , uk) is the Euclidean distance given in (3.19) and r is a fixed threshold. The structure of the
RP matrix usually shows short line segments of ones parallel to the main diagonal. The lengths of these
diagonal lines describe the duration of which the two points are close to each other. An example RP for
HRV time series is presented in Fig. 3.4. Methods for quantifying recurrence plots were proposed in [47].
The methods included in this software are introduced below.

In the software the following selections were made. The embedding dimension and lag were selected
to be m = 10 (default value) and τ = 1 (fixed), respectively. The threshold distance r was selected to
be
√
m SD (default value), where SD is the standard deviation of the RR time series. The selection are

similar to those made in [9].
The first quantitative measure of RP is the recurrence rate (REC) which is simply the ratio of ones

and zeros in the RP matrix. The number of elements in the RP matrix for τ = 1 is equal to N −m+ 1
and the recurrence rate is simply given as

REC =
1

(N −m+ 1)2

N−m+1∑
j,k=1

RP(j, k). (3.24)
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Figure 3.4: Recurrence plot matrix for HRV time series (black = 1 and white = 0).

The recurrence rate can also be calculated separately for each diagonal parallel to the line-of-identity
(main diagonal). The trend of REC as a function of the time distance between these diagonals and the
line-of-identity describes the fading of the recurrences for points further away.

The rest of the RP measures consider the lengths of the diagonal lines. A threshold lmin = 2 is used
for excluding the diagonal lines formed by tangential motion of the trajectory. The maximum line length
is denoted lmax and its inverse, the divergence,

DIV =
1

lmax
(3.25)

has been shown to correlate with the largest positive Lyapunov exponent [46]. The average diagonal line
length, on the other hand, is obtained as

lmean =

∑lmax

l=lmin
lNl∑lmax

l=lmin
Nl

(3.26)

where Nl is the number of length l lines. The determinism of the time series is measured by the variable

DET =

∑lmax

l=lmin
lNl∑N−m+1

j,k=1 RP(j, k)
. (3.27)

Finally, the Shannon information entropy of the line length distribution is defined as

ShanEn = −
lmax∑
l=lmin

nl lnnl (3.28)

where nl is the number of length l lines divided by the total number of lines, that is

nl =
Nl∑lmax

l′=lmin
Nl′

. (3.29)

3.4 Summary of HRV parameters

The presented time-domain, frequency-domain and nonlinear measures of HRV calculated by the software
are summarized in Table 3.1. For each measure, preferred units and a short description is given. In
addition, a reference to the equation in which the specific measure is defined is given when possible and
related references are given for some of the measures.
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Table 3.1: Summary of the HRV measures calculated by the software

Measure Units Description References

T
im

e
-D

o
m

a
in

RR [ms] The mean of RR intervals
STD RR (SDNN) [ms] Standard deviation of RR intervals [Eq. (3.1)]

HR [1/min] The mean heart rate
STD HR [1/min] Standard deviation of intantaneous heart rate values
RMSSD [ms] Square root of the mean squared differences between successive RR intervals [Eq.

(3.3)]
NN50 Number of successive RR interval pairs that differ more than 50 ms
pNN50 [%] NN50 divided by the total number of RR intervals [Eq. (3.4)]
HRV triangular
index

The integral of the RR interval histogram divided by the height of the histogram
[44]

TINN [ms] Baseline width of the RR interval histogram [44]

F
r
e
q
u
e
n
c
y
-D

o
m

a
in

Peak frequency [Hz] VLF, LF, and HF band peak frequencies
Absolute power [ms2] Absolute powers of VLF, LF, and HF bands
Relative power [%] Relative powers of VLF, LF, and HF bands

VLF [%] = VLF [ms2]/total power [ms2] × 100%
LF [%] = LF [ms2]/total power [ms2] × 100%
HF [%] = HF [ms2]/total power [ms2] × 100%

Normalized power [n.u.] Powers of LF and HF bands in normalized units
LF [n.u.] = LF [ms2]/(total power [ms2] − VLF [ms2])
HF [n.u.] = HF [ms2]/(total power [ms2] − VLF [ms2])

LF/HF Ratio between LF and HF band powers

N
o
n
li
n
e
a
r

SD1, SD2 [ms] The standard deviation of the Poincaré plot perpendicular to (SD1) and along (SD2)
the line-of-identity [6, 7]

ApEn Approximate entropy [Eq. (3.11)] [41, 14]
SampEn Sample entropy [Eq. (3.14)] [41]
D2 Correlation dimension [Eq. (3.21)] [17, 19]
DFA Detrended fluctuation analysis: [37, 38]
α1 Short term fluctuation slope
α2 Long term fluctuation slope

RPA Recurrence plot analysis: [47, 9, 49]

Lmean [beats] Mean line length [Eq. (3.26)]
Lmax [beats] Maximum line length
REC [%] Recurrence rate [Eq. (3.24)]
DET [%] Determinism [Eq. (3.27)]
ShanEn Shannon entropy [Eq. (3.28)]

Kubios HRV
version 2.2

Biosignal Analysis and Medical Imaging Group, Department of Applied Physics
University of Eastern Finland, Kuopio, FINLAND



Chapter 4

Software description

4.1 Input data formats

Kubios HRV supports the following data formats:

1. Biopac AcqKnowledge files (Biopac Systems Inc.) (*.acq)

2. European data format (EDF) files (*.edf)

3. General data format (GDF) files (*.gdf)

4. ECG ASCII data files (*.txt,*.dat)

5. Polar HRM files (Polar Electro Ltd.) (*.hrm)

6. Suunto SDF/STE files (Suunto Ltd.) (*.sdf,*.ste)

7. Garmin FIT files (Garmin Ltd.) (*.fit)

8. RR interval ASCII files (*.txt,*.dat)

9. Custom ASCII data files (*.txt,*.dat)

10. Kubios HRV Matlab MAT files (*.mat)

The three first ones (Biopac ACQ, EDF and GDF) are binary data formats. When any of these data
format files are read to the software, Kubios HRV automatically tries to determine the ECG channel from
the channel labels. If the ECG channel cannot be determined (or more than one channels are identified as
ECG channels), the software prompts the user to select the appropriate channel. Due to internal design
restrictions of Kubios HRV, the channel labels should only contain alphabets, numbers, and underscores.
If the channel labels contain other characters, such as spaces or plus signs, etc., these characters are
changed to underscores. Furthermore, the channel label should start with an alphabet. If this is not the
case, “Ch ” is added to the beginning of the channel label.

In addition to the above binary formats, Kubios HRV supports also ASCII ECG data which must be
given in the form

Type 1 Type 2

-0.173 0 -0.173
-0.119 0.002 -0.119
-0.025 0.004 -0.025
0.091 0.006 0.091
0.218 0.008 0.218

...
...

...

where the first column on the second format type is the time scale in seconds for the ECG data. The
sampling rate of this example file is, thus, 500 Hz. If ECG data is given according to the first type, user
is requested to enter the sampling rate manually. In addition to these ECG file support options, Kubios
HRV supports three RR interval file formats as described below.

Kubios HRV supports the following RR interval file formats. First of all, data of three commonly
used heart rate monitor manufacturers are supported. These are SUUNTO SDF/STE, POLAR HRM
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4.1. Input data formats 22

Figure 4.1: The interface for importing customized ASCII data files into the software.

files and GARMIN FIT files. When analyzing data of these devices it should however be noted that the
RR intervals must be measured/stored in beat-to-beat! If only averaged data (e.g. HR values at every
5 seconds) are stored, one can not perform HRV analyses. In addition Polar, Suunto and Garmin file
formats, a support for plain RR interval ASCII text files is provided. The input ASCII file can include
RR interval values in one or two column format. That is, The RR interval values can be given as

Type 1 Type 2

0.759 0.759 0.759
0.690 1.449 0.690
0.702 2.151 0.702
0.712 2.863 0.712
0.773 3.636 0.773

...
...

...

So in the second type of input the first column includes the time indexes of R wave detections (zero time
for the first detection) and second column the RR interval values. The RR interval values above are given
in seconds, but millisecond values can also be given.

In addition to above file formats, a custom ASCII file option is also provided. Using this option you
can import ASCII files including header lines and/or several data columns. Once you have selected an
input file, an interface for importing the file into Kubios is opened. This interface is shown in Fig. 4.1.
Through this interface you can specify the following required details corresponding to your data file

• Number of header lines

• Column separator (tab/space, comma, or semicolon)
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• Data type (ECG or RR)

• Data column (the ordinal number of data column)

• Data units (µV, V or mV for ECG / ms or s for RR)

• Time index column (the ordinal number of time indexes)

• Time units (units of time indexes in ms, s or date/time format)

• ECG sampling rate in Hz (if no time index column defined for ECG).

Once you have specified the above values for your file, press OK to proceed to analysis.
Finally, the software supports also MATLABr MAT files saved by the software itself. When you are

using Kubios HRV, you can save the analysis results also into a Matlab MAT file as described in Section
4.3.3. These result files include all the analysis results and analysis parameters, exactly as they where
when you saved the results. In addition, these files include the raw data (ECG or RR data). Therefore,
you are able to return to already analyzed data simply by opening the saved MAT file again in Kubios
HRV. The software will open with the settings that you have used when saving the results (e.g. including
the selected analysis samples). So this is the simplest way to return to previously analyzed data and
perhaps change some analysis parameter and re-compute the results. In addition, the MAT file are also
useful for anyone working with Matlab.

4.2 The user interface

The developed HRV analysis software is operated with a graphical user interface. This user interface
window is shown in Fig. 4.2. The user interface is divided into four segments: 1) the RR interval series
options segment on the top left corner, 2) the data browser segment on the top right corner, 3) the
analysis options segment on the bottom left corner, and 4) the results view segment on the bottom right
corner. Each of these segments are described in Sections 4.2.1, 4.2.2, 4.2.3, and 4.2.4, respectively.

4.2.1 RR interval series options

The RR interval series options shown in Fig. 4.3 include three functions: Artifact correction, Samples for
analysis, and Remove trend components. The artifact correction options can be used to correct artifacts
from a corrupted RR interval series. The user can select between very low, low, medium, strong, and very
strong correction levels. In addition, a custom level in seconds can be set. The different correction levels
define thresholds (very low=0.45 sec, low=0.35 sec, medium=0.25 sec, strong=0.15 sec, very strong=0.05
sec) for detecting RR intervals differing “abnormally” from the local mean RR interval. For example,
the correction level ”medium” will identify all RR intervals which are bigger/smaller than 0.25 seconds
compared to the local average. Furthermore, the above correction thresholds are for 60 beats/min heart
rate, for higher heart rates the thresholds are smaller (because the variability is expected to decrease
when HR increases). The corrections to be made on the RR series are displayed on the RR interval axis.
To make the corrections press the Apply button. A piecewise cubic spline interpolation method is used
in the corrections. You can reverse the correction by pressing the Undo button or by selecting none as
the correction level. It should be noted that artifact correction generates missing or corrupted values
into the RR series by interpolation and can cause distortion into the analysis results. Note that if ECG
is measured, the corrections should always be done by editing the R-peak marks in the ECG data as
described in Section 4.2.2.

An example of artifact correction can be seen in Fig. 4.4. In this case, the analyzed RR interval sample
includes two clear artifacts. In order to remove these artifacts a medium level correction was selected.
The effect of correction can be verified from the user interface, i.e. the corrected series is displayed on
top of the raw RR interval series as can be seen from Fig. 4.4 (a). The percentage of corrected beats
is also displayed on the right side of the RR series axis. The correction level can be accepted and the
correction performed by pressing the Apply button. The corrected series is shown in Fig. 4.4 (b). As
can be seen from Figs. 4.4 (a) and (b), the correction of just few artifacts has a very significant effect
on the time-domain analysis results. Thus, even single artifacts should always be taken care of prior to
HRV analysis.

In the Samples for analysis options the part(s) of the RR interval series to be analyzed can be modified
by adding or removing samples and by changing the start time or length of the sample. If more than
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Figure 4.2: The graphical user interface of the developed HRV analysis software.

Figure 4.3: The RR interval series options segment of the user interface.

one sample is selected, the analysis can be done either for the single samples separately or by merging
the samples into one long sample before analysis. This selection is visible under the RR series axis when
multiple samples are selected. The starting point and length of the samples can also be changed by
moving/resizing the patch over the RR series as described in Section 4.2.2. This section also describes
how to add/remove samples to/from RR series axes.

Sometimes the RR interval time series includes a disturbing low frequency baseline trend component.
Detrending options can be used to remove this kind of trend components. Detrending options include
removal of the first, second, or third order linear trend or the trend can be removed using a method called
smoothness priors which was presented in [43]. In the smoothness priors method, the smoothness of the
removed trend can be adjusted by editing the Lambda value. The smoothness priors method is basically
a time-varying high pass filter and its cut-off frequency can be adjusted with the Lambda parameter (the
bigger the value of Lambda the smoother is the removed trend). The estimated cut-off frequency for
the given Lambda value is presented next to the Lambda value edit box. In addition, the trend to be
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(a)

(b)

Figure 4.4: Artifact correction: (a) the artifact corrected series is visualized on top of the raw RR interval
series. (b) Corrected RR interval series.

removed from the RRI series is shown over the selected part of the RR series as a red line.

4.2.2 Data browser

The data browser segment shown in Fig. 4.5 displays the measured ECG signal and the extracted RR
interval series. It should be noted that if only RR interval data is given as input the ECG axis will not
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Figure 4.5: The data browser segment of the user interface.

be displayed and the RR series axis will be bigger in size. The ECG and RR interval data can be scrolled
with the two sliders. The position of the ECG axis is displayed as a green patch in the RR axis. This
patch can also be moved with the left mouse button. The range of both axes can be changed by editing
the Range values and also the Y-limits of the axes can be manually changed by editing the edit boxes on
the left hand side of the axes. The ECG and RR interval axes can also be scrolled together by locking
the axes by pressing the “Lock” button on the right side of the RR axis slider.

In addition to the visualization of the ECG and RR interval data, the main function of this segment
is to enable correction of corrupted RR interval values. This can be done in two ways. If only RR data
is available, the artifact corrections described in Section 4.2.1 are displayed in the RR axis. If the ECG
is measured, these corrections can be made by editing the misdetected R-peak as follows. Each detected
R-peak is marked in the ECG axis with a “+” mark. Each mark can be moved or removed by right
clicking it with the mouse (see Fig. 4.5). In addition, new R-peak markers can be added by either right
clicking some other marker and selecting Add or by pressing the uppermost button on the right hand
side of the ECG axis. Moved or added R-peak markers are by default snapped to closed ECG maximum,
but manual positioning can also be achieved by pressing the middle button on the right hand side of the
ECG axis. The changes made in R-peak markers will be automatically updated to RR interval series.

The selected sample(s) (yellow patches in the RR axis) can be modified with mouse as follows. Each
sample can be moved by grabbing it from the middle with the left mouse button and resized by grabbing
it from the left or right edge. You can also add a new sample to a specific location in the RR series by
right clicking the RR axis. The new sample will start from the clicked time instant and the length of the
new sample is by default same as the previous sample. After right clicking the RR axis a small popup
window opens in which the sample start time and length can be accepted/modified. When more than
one samples are selected, a sample can be removed by right clicking it with the mouse.

In addition, the data browser segment includes buttons for displaying a printout of the ECG recording
(on the right hand side of the ECG axis), moving the ECG axis view to the beginning of a selected sample
(on the right hand side of the ECG axis), scrolling the markers of the recording session (below the ECG
axis), and changing the RR series display mode (on the right hand side of the RR axis). An example
of the ECG printout is shown in Fig. 4.6. When clicking on the button for displaying a printout of the
ECG recording, a popup window will appear in which you can select the range for the ECG to be printed
(e.g. the whole recording or the range of the analysed sample). In addition, you can adjust “print speed”
in mm/sec of the ECG in this popup window. Once you have defined the range for ECG printout and
clicked the OK button, the ECG signal is displayed in a similar window as the report sheet and has, thus,
e.g. the same kind of exporting functions (see Section 4.3.2 for details).

4.2.3 Analysis options

The analysis options segment shown in Fig. 4.7 includes three subcategories: Frequency bands, Interpo-
lation of RR series, and Spectrum estimation. All of these options are concerned with frequency-domain
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Figure 4.6: The printout of the ECG signal generated by the software.

analysis.
The very low frequency (VLF), low frequency (LF), and high frequency (HF) bands of HRV frequency-

domain analysis can be adjusted by editing the VLF, LF, and HF values. The default values for the bands
are VLF: 0–0.04 Hz, LF: 0.04–0.15 Hz, and HF: 0.15–0.4 Hz according to [44]. The default values for the
bands can be restored by pressing the Defaults button.

The RR interval time series is an irregularly time sampled series as discussed in Section 2.2 and, thus,
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Figure 4.7: The analysis options segment of the user interface.

spectrum estimation methods can not be applied directly. In this software, this problem is solved by using
interpolation methods for converting the RR series into equidistantly sampled form. As the interpolation
method a piecewise cubic spline interpolation is used. The sampling rate of the interpolation can be
adjusted by editing the Interpolation rate value. By default a 4 Hz interpolation is used.

The spectrum for the selected RR interval sample is calculated both with Welch’s periodogram method
(FFT spectrum) and with an autoregressive modeling based method (AR spectrum). In the Welch’s
periodogram method, the used window width and window overlap can be adjusted by editing the cor-
responding value. The default value for window width is 256 seconds and the default overlap is 50 %
(corresponding to 128 seconds). In the AR spectrum, there are also two options that can be selected.
First, the order of the used AR model can be selected. The default value for the model order is 16, but
the model order should always be at least twice the number of spectral peaks in the data. The second
option is whether or not to use spectral factorization in the AR spectrum estimation. In the factorization
the Ar spectrum is divided into separate components and the power estimates of each component are
used for the band powers. The factorization, however, has some serious problems which can distort the
results significantly. The main problems are the selection of the model order in such a way that only
one AR component will result in each frequency band and, secondly, negative power values can result for
closely spaced AR components. Thus, the selection of not to use factorization in AR spectrum is surely
more robust and in that sense recommended.

4.2.4 Results view

The results for the selected RR interval sample are displayed in the results view segment. The results
are divided into time-domain, frequency-domain and nonlinear results. The results of each section are
displayed by pressing the corresponding button on the top of the results view segment. The results are
by default updated automatically whenever any one of the the sample or analysis options that effect on
the results is changed. The updating of the results can be time consuming for longer samples and in that
case it might be useful to disable the automatic update by unchecking the Automatic check box in the
bottom left corner of the user interface. When unchecked, one or more changes to options can be made
without updating breaks and when finished with changes the Apply button can be pressed to update the
results.

The time-domain results view shown in Fig. 4.8 displays the time-domain variables in a table and
the RR interval and heart rate histograms in the two axes. Most of the results are calculated from
the detrended RR series (if detrending is applied), but there are two obvious exceptions (i.e. mean RR
interval and mean HR) which are marker with the ∗ symbol.

The frequency-domain results view shown in Fig. 4.9 displays the results for both FFT and AR
spectrum estimation methods. Both methods are applied to the detrended RR series. The spectra of the
two methods are presented in the two axes (FFT spectrum on the left and AR spectrum on the right).
The frequency axes of the spectra are fixed to range from 0 Hz to the upper limit of HF band plus 0.1
Hz. Thus, for the default frequency band settings the frequency axis range is 0–0.5 Hz. The power axes
of the spectra, on the other hand, can be adjusted with the options on the upper right corner of the
frequency-domain results view. The power axes can be selected to have either common or separate upper
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Figure 4.8: The results view segment of the user interface: time-domain results view selected.

Figure 4.9: The results view segment of the user interface: frequency-domain results view selected.

Y-limits. If common Y-limit is selected, it can also be entered manually into the edit box below the
selection button. The selected power axis options apply also for the report sheet. The results for both
spectra are displayed in tables below the corresponding spectrum axes. If ECG is measured, an estimate
of the respiration frequency is also computed. This estimate, i.e. electrocardiogram derived respiration
(EDR) is shown as a vertical line in both spectrum estimates. The EDR value is also shown on the right
below the spectrum Y-limit options.

The nonlinear results view shown in Fig. 4.10 displays all the calculated nonlinear variables in one
table. All the variables are calculated from the original non-detrended RR series. The Poincaré plot and
the DFA results are also presented graphically in the two axes. In the Poincaré plot (left hand axis),
the successive RR intervals are plotted as blue circles and the SD1 and SD2 variables obtained from the
ellipse fitting technique are presented (for details see Section 3.3.1). In the DFA plot (right hand axis),
the detrended fluctuations F (n) are presented as a function of n in a log-log scale and the slopes for
the short term and long term fluctuations α1 and α2, respectively, are indicated (for details see Section
3.3.5).

4.2.5 Menus and toolbar buttons

The user menus and toolbar buttons are located on the upper left hand corner of the user interface.
There are all together three user menus and seven toolbar buttons. The toolbar button icons and their
actions are given below
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Figure 4.10: The results view segment of the user interface: nonlinear results view selected.

Open new data file button is for opening a new data file for anal-
ysis. If the results of the current analysis have not been saved, user
is prompted to do so.

Save results button is for saving the analysis results. The results
can be saved in ASCII, PDF, and MATLABr MAT file format (see
Section 4.3 for details).

Print results button is for printing the current results without open-
ing report sheet windows.

Report sheet button opens one or several report sheet windows
which include all the analysis results (see Section 4.3.2 for details).

Edit preferences button opens a preferences window in which you
can, e.g., change the default values for analysis options (see Section
4.4 for details).

About HRV analysis software button opens the about dialog of
the software which includes the version number and contact infor-
mation. Also the Kubios HRV End User License Agreement can be
viewed in the about dialog.

Open Kubios HRV User’s Guide button opens the Kubios HRV
User’s Guide (this document) PDF-file using the default PDF viewer
of the system.

Close file button closes the current data file. If the results of the
current analysis have not been saved, user is prompted to do so.

All the above actions are also available on the user menus. The File menu includes Open, Save Results,
Save Results As, Print Results, Edit Preferences, Close, and Quit commands. The Open, Save Results,
Edit Preferences, and Close commands work exactly as the corresponding toolbar buttons. The difference
between the Save and Save As commands is that when the results have already been saved, the Save
command automatically overwrites these results, whereas the Save As command asks the user for a new
file name. The Quit command of the File menu is for exiting from the software. The View menu includes
Markers menu and Report sheet command. The latter works as the corresponding toolbar button. The
Markers menu, on the other hand, is for displaying possible stimuli or event markers presented in the
experimental procedure and stored in the data file. If no markers are found from the data file the Markers
menu will be disabled. Finally, the Help menu includes the About HRV Analysis Software command which
opens the same about dialog as the corresponding toolbar button.

4.3 Saving the results

The analysis results can be saved by selecting Save Results or Save Results As from the File menu or by
pressing the save button on the toolbar. This will open a file save dialog in which the saving type can be
selected. There are three different types in which the results can be saved. That is, the results can be
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written in an ASCII text file for further inspection, the report sheets generated from the results can be
saved in a PDF-file, or the results can be saved in a MATLABr MAT-file.

4.3.1 ASCII-file

When the ASCII text file is selected for the saving type, the numeric results of the analysis will be written
in an ASCII text file. The resulting text file includes the following information in the enumerated order.

1. Software, user, and data file informations

2. Used analysis parameters

3. Samples selected for analysis

4. Time-domain results

5. Frequency-domain results

6. Nonlinear results

7. RR interval data and spectrum estimates

The columns of the file are separated with semicolons so that the results could easily be imported to,
e.g., spreadsheet programs such as the Microsoft Excelr for further inspection.

Note that there is also an alternative for the ASCII-file format. The analysis results can be also saved
in an SPSS friendly format, where all the parameter values are saved in one row. The column headers are
named according to the parameter names, but in SPSS compatible strings. If you have analyzed more
than one sample, the results for different samples are presented in separate rows (one row per analyzed
sample). This functionality was implemented in order the user’s to be able to easily construct SPSS
compatible text files for their patient data. That is, if you are analyzing data of several patients, just
save the “SPSS fiendly” text files for each patient, and then finally copy paste all the results in one text
file with the column headers (one row for each patient). This text file can then be easily imported to
SPSS. NOTE: you need to select this alternative format from the Preferences under Report settings (see
Section 4.4) because by default it’s not selected.

4.3.2 Report sheet

The software generates a printable report sheet which present all the analysis results. The report sheet,
shown in Fig. 4.11, includes all the time-domain, frequency-domain, and nonlinear analysis results. The
RR interval data and the sample selected for analysis are presented on the two axes on top of both sheet
and the analysis results below them. If multiple analysis samples have been selected, a report sheet is
generated for each sample.

When Save Results have been selected, the report sheet(s) can be saved in a single PDF-file by
selecting Report figure as the saving type in the save dialog. In this case, the report sheet(s) will not be
displayed, but just saved in the selected PDF-file. If you wish to view the report sheet(s) and/or to export
it into some other file format choose Report sheet from the View menu or just press the corresponding
toolbar button. This will open the report sheet windows for view.

The report sheet window includes 7 toolbar buttons and File and Page menus on the upper left hand
corners of the windows. The toolbar button icons and their actions are given below

Print button opens a print dialog from which the report sheet can
sent to the selected printer.

Export all pages to PDF-file button is for exporting all report
sheets into a single PDF-file.

Zoom in button if for zooming in (magnifying) the report sheet.

Zoom out button is for zooming out the report sheet.

Reset to original size button can be used to restore the original
zoom level. This also resets the size of the corresponding report sheet
window to its original size.

Move visible area button is for moving the visible area of the
zoomed report sheet in the report window (just grab the sheet with
mouse and drag it to the desired direction).

Close button is for closing the report sheet.
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Figure 4.11: The first report sheet including all the time-domain, frequency-domain, and nonlinear
analysis results calculated by the software.

The File menu includes Export All to PDF, Print Current Page, Print All Pages, Close, and Close
All commands. The Export All to PDF, Print All Pages, and Close commands are also given as toolbar
buttons described above. The last command Close All can be used for closing all report sheets simul-
taneously. The Edit menu (Windows version only) contains Copy to Clipboard option, which copies
the contents of the corresponding report sheet window to the Windows clipboard. This can be used to
quickly copying the report sheet as an image into another program. The Page menu includes commands
for changing for the previous or the next report sheet page and for changing the sheet by its page number.
However, the Page menu is not shown if only one report sheet window is open.
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4.3.3 Matlab MAT-file

In addition to saving the numeric results into an ASCII text file or saving the report sheet(s) in a PDF-
file, the analysis results can also be saved in a MATLABr MAT-file (compatible with MATLABr R12 or
higher). The MAT-file includes a single structured array variable named Res. The Res variable includes
the numeric results as well as the RR interval data and all the analysis options. This saving option is
aimed for MATLAB users and makes the further analysis or processing of the HRV data in MATLAB
much easier. The Res structure includes four fields which are shortly described as follows

f name: File name of the analyzed data file
f path: Full path for the analyzed data file

CNT: Basic information of the data file (the field name refers to Neuroscan CNT-file
for historical reasons)

HRV: Used analysis options, RR interval data, and all analysis results.

The HRV field is clearly the most essential one of these fields. The HRV field includes six fields the
contents of which are shortly described as follows

Param: The analysis options used in the calculation of the results
Data: The RR interval data

Statistics: Time-domain analysis results
Frequency: Frequency-domain analysis results
NonLinear: Nonlinear analysis results

The variable names of the different fields are more or less self-descriptive and are not documented here.

4.4 Setting up the preferences

All the analysis options that can be adjusted in the user interface have some default values. These
preference values will be used every time the program is started. Any changes made on these values in
the user interface only apply for the current session. The preference values are designed to be more or
less suitable for short-term HRV recordings and may sometimes need to be redefined. This can be done
by selecting Edit Preferences from the File menu or by pressing the corresponding toolbar button. This
will open the preferences window in which the preference values can be redefined. The preferences are
divided into four categories: User information, Analysis options, Advanced settings, and Report settings.

In the User information category shown in Fig. 4.12 you can set up your personal contact
information (Name, Department, and Organization). This information will only be included in the
bottom left corner of the report sheet and in the beginning of the ASCII text file including the analysis
results. That is, the user information is meant just for indicating the person who has carried out the
analysis.

The Analysis options category shown in Fig. 4.13 includes some basic analysis options. The default
input data type can be set to one of the file formats mentioned in Section 4.1 and the selected data type
will be used as default every time a new data file is opened. In addition, the analysis options category
includes RR interval samples, RR interval detrending, HRV frequency bands, and Update analysis results
options which have already been described in Sections 4.2.1, 4.2.3, and 4.2.4.

The Advanced settings category shown in Figa. 4.14 and 4.15 is divided into two pages. The first
page includes QRS detection and Spectrum estimation options. In the QRS detection options you can
set up the prior guess for the average RR interval. By default this prior guess is estimated automatically.
This may not, however, always work (e.g. for some animal data) in which case the prior guess for the
RR interval value should be fixed to the supposed value. The spectrum estimation options include one
additional option compared to those described in Section 4.2.3, i.e. points in frequency-domain option.
The points in frequency-domain is given as points/Hz and corresponds by default to the window width of
the FFT spectrum. If spectrum interpolation is desired the points in frequency-domain can be increased.

The second page of the Advanced settings category includes options for nonlinear analysis. The em-
bedding dimension m and the tolerance value r used in for the computation of Approximate entropy
(ApEn) and Sample entropy (SampEn) can be modified. Note that the tolerance value is adjusted in
relation to the standard deviation of the RR interval data. Next, limits of the short-term (N1) and
long-term fluctuations used in the Detrended fluctuation analysis (DFA) can be modified. Finally, the
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Figure 4.12: Set up preferences window of the software: User information category.

Figure 4.13: Set up preferences window of the software: Analysis options category.

embedding dimension used both in the computation of the Correlation dimension (D2) and in the Recur-
rence plot analysis (RPA), and the threshold level used in RPA, can be modified. For more information
on the meaning of these different options see Section 3.3.

The Report settings category shown in Fig. 4.16 includes the following options. The paper size
of the report sheet can be changed between A4 (210×297 mm) and Letter (8.5×11 inch) size. The default
paper size is A4. In addition, the field delimiter and decimal point used when saving the results in an
ASCII file can be selected. Here you can also select to save the results in an “SPSS friendly” format
described in Section 4.3.1. The Custom Print Command option allows the use of an external program to
print the report sheets in PostScript format.

All modifications for the preferences are saved by pressing the OK button. Note that the OK button
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Figure 4.14: Set up preferences window of the software: Advanced settings category I.

Figure 4.15: Set up preferences window of the software: Advanced settings category II.

saves the preferences, but they will be applied only in the next session. A session is considered to be
ended when the program is restarted or Close file is selected. If, on the other hand, a new file is opened
(without first closing the previous file) preferences will not be applied, but the local settings (changes
made in the user interface) are applied for the new file as well.

In addition to the actual analysis options, there are various other editable options which have mainly
influence on the usability of the software. Such options are e.g. the Range and Y-limit values of the data
axis and various visualization options. The values of these options are preserved in memory and any
changes made to them will be applied in the future sessions. Also the preference directories path from
where the data file is searched for and in which the results are saved are preserved in memory. The last
nine opened data files will also appear in the File menu of the user interface and can be reopened from
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Figure 4.16: Set up preferences window of the software: Report settings category.

there.
All the preferences and preserved options used by Kubios HRV are saved in user specific folders1.

Windows XP:

C:\Documents and Settings\<username>\Application Data\KubiosHRV

Windows Vista/Windows 7:

C:\Users\<username>\AppData\Roaming\KubiosHRV

Linux:

/home/<username>/.kubioshrv

where <username> is the name of your user profile. The folder will include three files: hrv_pref.dat,
user_pref.dat, and HRVprefs.mat. The hrv_pref.dat file includes all the preferences for the analysis
options, user_pref.dat includes the user information preferences, and HRVprefs.mat all the preferences
related to the usability of the software. These files are created when the software is started for the first
time and they will be updated whenever the preference values are edited. The original settings of the
preferences can be restored by deleting these files.

1Note that the Application Data folder in Windows XP and AppData folder in Windows Vista and 7 are hidden by
default and are not visible in the Windows File Explorer if the “Show hidden files and folders” is not selected from the
“Folder Options” section of the File Explorer.
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Chapter 5

Sample run

In this chapter, we present a sample run of the software. The sample run is made for the GDF data file
(gdf_ecg_data.gdf) distributed with this software. The sample data is measured from a healthy young
male during an orthostatic test. The change in the posture is known to be reflected in the low frequency
and high frequency HRV in an opposite way. That is, when subject stands up after lying for few minutes
a strong decrease in the HF power and a more gradual increase in LF power are observed. In addition,
a strong increase in heart rate is observed immediately after standing up, which aims to compensate the
sudden decrease in blood pressure. In the sample run, this data file is analyzed by considering the lying
and standing periods separately.

5.1 Sample run

In this sample run, we show how to make the time-domain, frequency-domain, and nonlinear analysis,
for the lying and standing periods of the orthostatic measurement separately. This task can be easily
accomplished in a single session. First, start the software and open the data file into the user interface.
At this point, you can edit any of the analysis options to fit your demands. If you are about to analyze
several data files with the same options, you better make these changes straight to the preferences.

The next thing to do is to select the RR interval samples to be analyzed. First, add a new sample
to the RR interval axes because we want to analyze both the lying and standing periods. To do this,
you can simply right click the RR axes, press Yes to the Add sample popup window, and OK to verify
the sample properties. Now you will have two samples shown as yellow patches in the RR interval axes.
Then change the sample ranges to cover the periods or interest as shown in Fig. 5.1. The easies way to
change the samples’ ranges is to edit them with the mouse as described in Section 4.2.2, but the ranges
can also be changed by editing the Start and Length values in RR interval series options segment. Then
check that the Sample analysis type option under the RR axis is set for Single samples. Then, analysis
results are calculated for both samples separately. If, on the other hand, Merge samples is selected, then
the two samples are first merged into one sample and the analysis results are calculated for this merged
sample.

Since we are now only interested in the changes in LF and HF bands, we wish to remove the low-
est frequency trend components from the RR series. These trend components affect on the time and
frequency-domain variables and, thus, by removing the trend from the data enables these variables to
better describe the LF and HF variability which we are interested of. We select to remove the trend with
the smoothness priors based method. Once the detrending method is selected red lines appear over the
RR interval data indicating the removed trend components. The smoothness of the removed trend in
the smoothness priors method can be adjusted by changing the Lambda value. The smoothness priors
detrending method can be compared to a high-pass filter in which the cutoff frequency is determined
from the lambda value (bigger lambda corresponds to lower cutoff). The estimated cutoff frequency of
the detreding method is also shown next to the Lambda value. Since we are now interested in LF and
HF frequencies, we wish to make sure that the detrending does not remove those frequencies. This can
be easily done by changing the Lambda value in such a way that the cutoff frequency is below 0.04 Hz.
The effect of detrending can also be verified by inspecting how it changes the FFT spectrum. Here, we
set the Lambda value to 500.

The time-domain, frequency-domain, and nonlinear analysis results for the selected samples can then
be viewed in the results view segment. Just make sure that the results have been updated (check that
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Figure 5.1: Sample run 1.

the Automatic is checked in Apply changes and if not press the Apply button). Press the Time-domain,
Frequency-domain, or Nonlinear buttons to view the corresponding results. Note that the results are
shown only for one of the samples at a time. To take a look at the results of the other sample press
the � or � button on the top right corner of the results view segment (the text on the left changes to
indicate which sample’s results are shown, this sample will also be highlighted in the RR series axis).
Note that you can force a common Y-limit for the spectra of both samples by setting a common Y-limit
value manually in the frequency-domain results view. For example, we have here fixed the Y-limit value
to 0.04 s2/Hz.

Once we are done with the analysis, we wish to save the analysis results in all possible formats. This
can be done by selecting Save Results from the File menu or just by pressing the save button on the
toolbar. Then select Save all (*.txt,*.mat,*.pdf) as the save type and enter a file name. You do
not need to give any extension to the file name. The numeric results of the analysis will be saved in
the *.txt text file, in the *.mat MATLAB file and the report sheets in the *.pdf file. The generated
PDF-file will now include two pages, one for the results of the first RR interval sample (the lying period)
and one for the second sample (standing period). These report sheet pages are shown in Figs. 5.2 and
5.3. In the text file, the results for the two samples are presented side by side as can be seen from Fig.
5.4. Note that you can also save the results in the “SPSS friendly” formatted text file if you select this
option from the software preferences. If this option is selected the text file looks like the one shown in
Fig. 5.5. That is all the parameter values are written in one row. The column headers indicate the
corresponding parameter and the sample (_s1 indicates here the first sample, i.e. from the lying period).
After the results for the first sample, you will find the same results for the second sample (_s2).
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Figure 5.2: Sample run 1, results for the lying period of the orthostatic test.
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Figure 5.3: Sample run 1, results for the standing period of the orthostatic test.
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Figure 5.4: Sample run 1, results saved in an ASCII file.

Figure 5.5: Sample run 1, results saved in an SPSS friendly ASCII file.
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